
 
 
 
 
 
 
 

Course Objective 
 
In these two sessions, participants will be introduced to the basic 
features of Microsoft Word for the Mac. Participants will have 
hands-on experience with such features as highlighting, 
modifying text, cutting and pasting, use of spell and grammar 
check, and saving to a storage location. 
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Introduction to 
Microsoft Word 

For the Mac 



 
Introduction to the Microsoft Word Screen 
 
Going to a New Finder Window, click on Applications. Look for Microsoft 

Office 2004.   
 
Once Microsoft Office 2004 opens, click on the icon Microsoft Word.  

 This will open the first screen in Microsoft Word. The 
first screen is titled the Project Gallery – New. Selections can be made 
from the list in the left column that has the title Groups or from the 
image selection in the right column such as List Wizard, Mail Message, 
PowerPoint, Web Page, Word Document, and Word Notebook. We will 
select Blank Document in the left column or Word Document from the 
right column. 
 

 
 

© Ann Arbor District Library 1

 



 

 
 
When the Microsoft Word document opens on the Mac, it is quite different 
from Word on the PC.  The Standard toolbar and Formatting Palette seem 
to be floating. The Formatting Toolbar does not open automatically, but 
must be selected in order to use it. The Formatting Palette is the 
equivalent to the Formatting Toolbar. 
 
Standard Toolbar 

 
 
There are features on the Standard Toolbar that you may not be familiar 
with.  The Standard Toolbar has features such as Flag for follow up, 
Navigation Pane, and Toolbox. When opened the Toolbox is titled 
Scrapbook.        
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     Formatting Palette 
 

 

 
 

The Formatting Palette is unique to the Mac.  Once you become 
comfortable using the Palette, it is a very useful floating toolbar. By 
clicking on the various arrows, such as Styles, Font, Add Objects, the 
Palette selection will drop down with more options and the arrow will 
point downward. Clicking on the arrow again will close the options menu 
and the arrow will point to the right.  
 
You do have the option of closing out of the Palette and just use the 
Formatting Toolbar.  
 
Both the Formatting Palette and Formatting Toolbar can be found by 
going to View. The Formatting Palette can be clicked on or off. The 
Formatting Toolbar is found under View to Toolbars. The Formatting 
Toolbar can be clicked on or off. 
 
The Standard Toolbar can be moved into the same area you would find 
the toolbars on the PC by dragging the toolbar on the left end of the bar. 
There is a darker gray area with a circle. This is the area that drags the 
toolbar. The circle will close the toolbar. 
 

 
 
The Formatting Palette is easily used keeping it where it appears or it can 
be closed and the Formatting toolbar inserted next to the Standard 
Toolbar by going to View and slide to Toolbar and click on the Formatting 
toolbar. 
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           Drag area 

Drop down Font 
options. 



 
Formatting Toolbar 

 
 
To remove and add a button from a toolbar takes a different method from 
the PC. 
 

To add a button, click on the very end of the toolbar where the arrow 
indicates more buttons. 

 
 
At the end of the list of buttons that can be added is the option to 
Customize Toolbars/Menus.  
 

 
 
Clicking on the options will bring up the Customize Toolbar Menu.  
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Arrows indicate more 
buttons. 



 
You can check or uncheck the desired Toolbars. On the Commands menu, 
find the buttons to be added by selecting the Categories. Selecting the 
Categories will bring up the buttons under that Category. Drag the button 
you would like to add to the Toolbar. 
 

Views of the Microsoft Word Screen 
 
The Word screen is separate from the Standard, Formatting toolbars or 
the Formatting Palette. Holding down the mouse button on the Title Bar 
can move the Word screen. The Title Bar is the area of the Word screen 
that says Document 1 or the name of the file. 
 
         Moves Screen 

 
 
On the Mac, when you open a program, a Special Menu bar always 
appears at the top of the screen. The Special Menu bar will stay open 
until you close the program. The Special Menu bar is not a moveable 
item.  
 

 
 
In fact, the best way to close a program is to use the Special Menu bar. 
To close the program, you would go up to Word that is in bold (or the 
name of the program) and slide down to Quit.  
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Once the screen has been arranged to make using the toolbars and 
working in the document easy, the work can begin. 
 
Special Menu Bar            Standard Tool Bar          Formatting Toolbar 

 
 
  
 
 

 
                 Maximize is the third button.                
 
Underneath the title bar, you can select to have a ruler. The ruler can be 
found by going to View and either clicking the ruler on or off. The ruler 
indicates the margins of the page and tab stops. 
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 Close is the first button. Minimize is the second button. 

Scroll Bar Box 

 Up and Down Arrows 

  Previous Page 
  Select Browse Object 
  Next Page 

   Stripes resize the Word window.   
Holding down and moving the mouse 
over the stripes will resize the Word 
Window. 

     Title Bar 



 
 
 
The last section of the Word screen is known as the Status Bar. The 
Status Bar indicates the length of the document in pages, the page that is 
active, the placement of the cursor by section, line, and column. 
 

 
 
The four icons indicate Normal view, Outline view, Page Layout and 
Notebook Layout view. 
 

 
 
Visuals When Typing Text 
 

 
 

Blinking Cursor – is the point on the document where text can be 
typed. 
 
Ibar – is the coworker of the Cursor. The Ibar is your mouse. If you 
move your mouse, the Ibar will move. The Ibar helps move the Cursor to 
parts of the text screen. The Ibar calls the Cursor into a blank field 
(example Save As field). The Ibar works with the Cursor in text 
formatting such as highlighting. 
 
Arrow – the Ibar becomes an arrow if you move your mouse onto the 
Toolbar or Menu Bar. The Ibar becomes an arrow for selection of options. 
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Formatting Text with the Toolbar 
 
 Correcting text with the Ibar and Cursor. 
 Using Spell Check 
 Learning to Highlight 
 Making text changes with highlighting 

 centering text 
 size of font 
 type of font 

 Dragging Text 
 Undo with edit 
 Save to location 
 Print Preview 
 Print 
 
 
Please type: 
 
 
 Microsoft Word and Formatting 
 
We will learn how the Ibar and cursor work together to 
format the text that has been typed. The text must be 
highlighted before formatting. Formatting means a 
change in the size, font, or placement of the text. 
 
 
 
Correcting text with the Ibar and Cursor 
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The Ibar is placed where the correction is to be made. On a Mac if you 
are on a desktop computer, the deletion of a letter can be made with the 
delete key under the help button, or the delete key at the right end of the 
number row. Placement of the cursor does depend on which delete key is 
used. If you use the delete key under the help key, the cursor is placed to 
right of the letter. If you use the delete key at the end of the number 
row, the cursor is placed to the left of the letter. 



 

 
 

                                            
 
Where the blinking cursor is placed, a letter can be inserted or deleted 
from the text. 
  
 

Spell Check 
 
Spell Check is found under the Tools Menu.   
 

 
 
Spell Check and Grammar are in the same menu. As you type text, if a 
word becomes underlined in red, that means the word is misspelled. If a 
word, words or string of words is underlined in green that means it is a 
spacial or grammar problem. 
 
When using the spell check menu, the spelling errors will be in red. There 
will be a list of suggestions. You have to highlight the suggestion that is 
correct. Once you highlight the suggestion, you must click the Change 
button in order to the spelling error to be changed. 
 
The same procedure is followed when dealing with errors that are in 
green. Although there may be times you are not in agreement with the 
green error. 
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Spell Check Menu 
 
                      The spelling error is in red print. 

 
 
Highlight the correct suggestion and click on the Change button. 
 
Highlighting 
 
Highlighting covers the text that you want to change in a blue shadow. 
No change will occur to the parts of the text that were not highlighted. 
The cursor and Ibar work together to shadow the text.  
 
When working on the PC (not a Mac), the shadow is black and the words 
become white under the black shadow. On the Mac the words do not 
become white under the black shadow. The Mac’s shadow is blue and the 
words do not change color and the text is seen as black text. 
 
How to Highlight 
 
 Highlight by making the cursor active after the text you would like to 

highlight. 
 Keep the blinking cursor and the Ibar together.   
 Keeping the mouse button pressed, slide to the left over all of the 

words and then let go of the mouse.  All the words should be 
highlighted in a blue shadow.   
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Once text is highlighted, using the different options on the Toolbar 
changes can be made. 
 

 
 
Once part of or all of the text is highlighted a change can be made. In this 
case the font will be changed from Times New Roman to Verdana. 
 

 
 
Dragging Text 

 
Sometimes when highlighting, the mouse goes into the mode to drag 
text. When dragging text you can see the text move as you move the 
mouse. When the mouse is in the drag text mode, text can moved to 
another part of the screen. 
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Once the text has moved a small icon representing a clipboard appears. 
The clipboard offers three choices. By selecting “Keep Source 
Formatting”, a word formatted to be centered, will carry the centered 
formatting to the whole text. 
 

 
 
 
By selecting Edit and clicking on Undo (the very first option under Edit), 
the text will return to its original position. 
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Edit Undo 
 

Edit Undo is a great option to undo any mistakes or change that you 
made. The Undo button can remember all of the actions that you have 
taken while typing text. Be careful when choose Undo as Undo could undo 
all of your actions. But, of course, there is always Redo. 
 

Saving Your Work To Disk 
 

It is a good idea to save your work before you have completed all of it. It 
is best to start working on the document, stop and save, and then 
continue working. It is important after you save for the first time to 
continually stop as you are working and save again. The additional saves 
will save your new work to your document. 
 

Save As 
 

Save As is found under File on the Special Menu Bar. 
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When you are saving a file for the first time, you must tell the computer 
the name of the document, where you want the document saved, and the 
format the document will be saved as. 
 

 
 
 

        Where to save the file. 

 
 
 
Format type. 
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Name the file. 



 
 

Done  
 

The title bar on your document has now changed from document 1 to the 
name of the saved file. 
 
Print Preview 
 

Print Preview is found under File.  
 

 
 

Print Preview takes your document and puts it at a view that the whole 
layout can be seen. 
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When you are in Print Preview, you can see how your document is laid 
out on the paper. There is a magnifier on the toolbar of Print Preview that 
will enlarge the document. If you click the magnifier off, the cursor will 
become active on your document. At this point you can add, delete or 
move text. You cannot format in Print Preview. 
 
                           Magnifier 

 
 
The Close Button on the Print Preview toolbar will close Print Preview and 
go back to the document. 
 
                                                                     Close button 

 
 

Printing 
 
Printing is found under the File Menu on the Special Toolbar. 
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The print menu offers options that may be new to you. There are three 
fields with different options. 
 
 The first field provides options to add or change printers. 
 The second field gives options to save, rename or delete the 

document. 
 The third field deals with the printing of the paper. 
 
The lower part of the print menu deals with the fields for the printing of 
page ranges. 
 
There is an option to select Page Setup. The Page Setup option provides 
fields for Settings, Format for Printer, Page Size, option for Orientation 
and Scale. 
 
The bottom area of the print menu offers the options of saving the 
document as a PDF file.  Preview the document before printing, and 
Cancel or Print. 
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A PDF is a file format that was developed by Adobe Systems. This file 
format can capture formatting from different types of desktop publishing 
applications such as WordPerfect, Works, and Microsoft Word. When 



saved as a PDF, the file sent to a computer without the same word 
processing software will not be altered. The file will still contain the 
original formatting regardless if a Microsoft Word document is sent to a 
computer that only has WordPerfect. 
 
Mac, unlike the PC, offers the Adobe software as part of Mac applications. 
PC users have to download Adobe in order to save a file as a PDF. 
 
 
Formatting the Document 
 
Open Microsoft Word 
From the Microsoft Word Screen 
 Open the file from the location where it was saved. 
 Go to File and slide down to Page Setup 
 Change the left and right margins from 1.25” to 3.00” 
 Preview the changes 
 Close out of the file. 
 Open a new document. 
 
 
The left and right margins will be changed once the file is opened. In 
order to make changes to the margins, go to Format and slide down to 
Document. 
 
 

 
 
Selecting document will bring up a menu. 
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Before making changes to the margins, let’s take a look at the Layout 
Menu. 
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Going back to the Margins menu, change the left and right margins from 
1.25” to 3.00”. After making changes to the margins, take a look at your 
document through Print Preview. Remember Print Preview is under the 
File menu. 
 
Close the document, open a new one and type the text below. We will 
now learn some of the options that are available to change how are text 
looks. We will be looking at line spacing, use of numbers and bullets, cut 
and paste and page breaks. 
 
Type: 
 
 
Second Part Microsoft Word 
 
The Second Part of Microsoft Word will teach us the 
skills of: 
 
Cut and paste 
Spell check 
Formatting 
 
First we must learn about: 
 
The cursor and pointer 
Where text begins 
Highlighting 
 
 
 
 

Options To Format the Document 
 

 Paragraph Options 
 Cut and Paste (move the two paragraphs) 
 Bullets and Numbered Lists 
 Page Breaks 
 Draw (only if time permits) 
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Paragraph Options 
 
Paragraph Options can be found under the Format menu. 
 

 
 
 
 

The two options under Paragraph Options allow Indents, Line Spacing and 
inserting Page Breaks. Page Breaks can also be found under the Insert 
Menu. 
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Under the Spacing section of the menu, single, double or 1.5 line spacing 
can be selected. Highlight the text to be spaced and select the type of line 
spacing. 
 
Lines can also be spaced by keyboard shortcuts.  
 
 Apple key+1 for single spacing. 
 Apple key+2 for double spacing. 
 Apple key+5 for 1.5 line spacing. 
 For At Least, Exactly and Multiple see Word Help. 
 
 
 
 

© Ann Arbor District Library 22

 



Cut, Copy and Paste 
 
Cut, Copy and Paste can be found under the Edit. 
 

 
 

Once the text is highlighted and COPIED, it can either be PASTED to 
another document or PASTED to another part of the text page. 
 
Once the text is highlighted it can be CUT from the document entirely or 
CUT and PASTED to another document or to another part of the text 
page. 
 
There is a difference between CUT and COPY.  If you highlight text and 
CUT, the original text is gone and still in the memory of the computer 
to be PASTED.  If you highlight text and COPY, the original text is still 
in place and also in the memory of the computer to be PASTED. 
 
Bullets and Numbering 
 
Bullets and Numbering is found under the Format Menu. 
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The options available under the Bullets and Number menu are types of 
Bullets, Numbers, Outline Numbers, and List Styles. 
 

 
 

Page Breaks 
 
Page Breaks can be found under the Insert Menu 
 

 
 
Page Breaks offer quite a few choices from Page Break, Column Break, 
and Section Break. These types of breaks can be seen in an entirely 
different way depending on the View of the document. 
 
             Page Layout View 
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          Normal View 

 
 

It is up to the individual to decide what view works the best for them 
while they are working. 
 
Drawing Toolbar 
 
The Drawing Toolbar has to be added to the Word screen by going to 
View and add the Drawing Toolbar. 
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Once the Toolbar Drawing is selected a new floating toolbar will appear on 
the screen. Remember if a toolbar or menu is floating, that means you 
can move to the most convenient part of the screen for you to work. 
 

 

 
 
 
 

In Microsoft Word for Mac, the drawing toolbar appears vertically to the 
right of the screen. To use the tools, click on the tool you want to use, 
move to the text area of the Word screen.  The mouse turns into cross 

(+), instead of an arrow or an I Bar.   Holding down the left mouse 
button, the selected image can be drawn. If the object selected has an 
arrow to the right, that indicates more options and a menu will appear. 
Selection can be made from the menu. 
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Text Box 
 

WordArt 

 

Line 
 

Rectangle 

 
 Line Style 

Font Color 
 

Line Color 
Background Color 

Select Objects 



Microsoft Word Terms 
 
Blinking Cursor:  is the point on the document where text can be typed. 
 
Close Button: closes the Application, Program or File that is open.  The 
Close Button is found on the left side of the Title Bar with the Minimize 
and Maximize Buttons. 
                                 Close Button 
 

 
 

Copy:  text that is highlighted can be copied and placed in another part 
of the document or in an entirely different document.  The Copy function 
is found under Edit. 
 
Cut:  text that is highlighted can be cut and placed in another part of the 
document or in an entirely different document.  The Cut function is found 
under Edit. 
 
Dragging Text:  when text is highlighted, holding down the button of 
the mouse while moving the mouse will drag the text to a different 
location.  As you are dragging, you can see the text move. The text is 
dropped where the cursor is when you release the mouse button.    
 
Highlighting:  highlighting is done by placing the cursor near the text 
that needs to be formatted, and sliding over the text with the IBar. Once 
highlighted, the text appears against a black background, and formatting 
such as changing the letter size and style can be applied.     
 
IBar:  is the coworker of the Cursor.  The IBar helps move the Cursor 
throughout the text screen, calls the Cursor into a blank field for typing, 
and works with the Cursor when highlighting. 
 
Menu Bar:  contains all of the Commands and Options that are available 
in Microsoft Word. The Menu Bar is also known as the Special Menu Bar. 
The Special Menu Bar has different commands depending on the 
application be used. 
 
Maximize Button:  this button enlarges the open Application/Program 
window to cover a larger area of desktop. The Maximize Button is found 
on the left side of the Title Bar with the Minimize and Close Buttons. 
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                                               Maximize Button 
 

 
 
Minimize Button:  places the open Application/Program window on the 
Dock.  The Dock can be placed at the Bottom, Left, or Right of the Mac 
screen. The Minimize Button is found on the left side of the Title Bar with 
the Maximize and Close Buttons. 
 
                                           Minimize 
 

 
 

Paste:  the text that has been copied is held in the memory of the 
computer, called the clipboard.  The clipboard holds the 
text and allows the Paste command to place the text 
where indicated. 

 
Previous Page, Select Browse Object and Next Page: are buttons that 

can be found below the Scroll Bar on the right side of the 
screen.  The Previous Page and Next Page allows for the 
movement from one page to the next in a large document 
or file.  The Select Browse Object allows you to choose an 
object, icon, file or folder for manipulation of the text or 
document. 

 
Print Preview:  takes the document and displays it at a distance so the 
layout of the document can be seen before printing.  The Close button will 
take you back to the original document. 
 

 
 
Ruler:  the Ruler, located below the Menu and Toolbar, indicates the 
margins of the page and the tab stops. 
 
Title Bar:  the Title Bar displays the names of the Application/Program 
that is Open.  The Title Bar is located at the very top of the Word Screen 
and is gray in color. The Minimize, Maximize and Close button are also 
located on the left hand side of the Title Bar. 
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Tool Bar:  shows small icons of the most frequently used commands, 
function or options.  This bar can be customized to display the buttons 
that are used most often. 
 
Scroll Bar:  the Scroll Bar is located on the right side of the Microsoft 
Word screen.  The Scroll Bar has Up and Down Arrows and a Scroll Bar 
Box.  The Arrows and Scroll Bar Box allow for the up and down movement 
of text on a page.   
 

    Select All:  highlights all of the text with one click for editing purposes.  
Select All is found under the Edit Menu.    

 
     Special Menu Bar – is at the very top of the Mac screen. The Special Menu bar 

has the name of the application open, the commands available in 
the application and to the very right may contain date and time. The 
Special Menu Bar is not a movable item on the Mac screen. 

 
Status Bar:  indicates the length of the document in pages, the page, 
section, line, and column the cursor is on. 
 
Undo and Redo: the Undo and Redo options are found under the Edit 
Menu. They may also be found on the Tool Bar, as icons displaying curved 
arrows. The Undo button will bring back any formatting changes that 
were made.  For example, if you changed a font and wanted the original 
font again, the Undo button will change the font back.  If the second font 
turns out to be better, the Redo button will change the font again.   
 
Views:  there are several different ways the Microsoft Screen can be 
seen.  Normal Views brings you the whole screen without showing the 
gray areas of the margins.  The Online Layout shows the screen as it 
would with the parameters of the Internet. The Page Layout shows the 
screen with the margins in gray, showing how the page would look when 
printed.  The Outline view sets up the document to with levels or headers 
to organize the written text. The Notebook Layout structures the 
document as if the text was written in a lined notebook. 
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